
SIMI°BioCell 

Users Manual 

 

 



 

 II  



 

 III 

 
 
 

SIMI°BioCell 

Users Manual 
 
for Version 2.23 
 
 
ACKNOWLEDGEMENTS 
 
Special thanks to Prof. Ralf Schnabel and Titus Kaletta from the Max-
Planck-Institute for Biochemistry. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Serving our customers with an 
individual system tailored to their special needs… 



 

 IV  

Copyright Statement  
Copyright Any person who reproduces the SIMI°BioCell 

software or this User's Guide is liable to criminal 
prosecution. SIMI Reality Motion Systems 
GmbH reserves all rights to the User's Guide and 
the SIMI°BioCell software program. 
The legal acquisition of the User's Guide and the 
SIMI°BioCell program disks allows the licencee 
the use of these in accordance with the terms of 
the licence agreement. The copying, duplicating, 
selling or misuse of the product in any way is not 
permitted. 
No part of this documentation may be 
reproduced, copied, transcribed, transmitted, 
stored in a retrieval system, or translated into any 
language in any form by any means without the 
written permission of SIMI. 
 
Copyright ©1997-98 by SIMI GmbH. 
All rights reserved. 
 

Limitation of 
Warranty 

Every effort has been made to ensure that the 
information in this User's Guide is correct. 
However, no guarantee can be given for the 
accuracy of the contents. Since mistakes can 
never be completely avoided, we would be 
grateful for any suggestions for improving this 
publication. 
 

Publisher SIMI Reality Motion Systems GmbH 
Pappelgasse 5 
Postfach 1518 
D-85705 Unterschleissheim 
Germany 
Phone: +49-89-321 45 9-0 
Fax : +49-89-321 45 9-16 
E-Mail: simi@simi.net 
Web: www.simi.net 
 

Manual Titus Kaletta (kaletta@alpha.bio.nat.tu-bs.de) 
Toni Zeitler (zeitler@simi.net) 



 

 V 

Introduction 
Welcome to the fascinating possibilities of Cell Lineage 
Analysis…and thank you for choosing SIMI°BioCell. 
It will be a powerful tool to explore the embryo. 

The primary purpose of this Users Manual is to explain how to use 
SIMI°BioCell. It contains the detailed information you need to use this 
software to YOUR fullest ability. The manual's format facilitates its use as a 
reference volume, but you may find that at least one sequential, recreational-
type reading will provide a broader foundation upon which to understand the 
items you may want to investigate in depth later. 

It is important to understand at the outset that SIMI°BioCell is not like any 
other program. The interface is very intuitive, the controls and tools look and 
act similar to those you have used in other IBM compatible software, and the 
software keeps you informed every step of the way. You should read this 
manual to tap the full capability of SIMI°BioCell.. 

In 1994, a co-operation between us and Prof. Ralf Schnabel (Max-Planck-
Institute for Biochemistry, Munich) started to develop a software to 
investigate embryogenesis. The technical part was SIMI°Motion, the 
software for two- or three-dimensional motion analysis, the biological part 
was a worm with a transparent embryogenesis and the medium was a time-
lapsed video recording acquired by a 4d-microscope. The result was 
SIMI°BioCell that is able to track the cells, their division pattern and their 
specification as tissues during the development into a worm. 

In the meantime SIMI°Motion offers a wide range of components to 
assemble an individual system. Our modules from "filters" and "automatic 
marker recognition" up to "highspeed video" have been designed from the 
practice in close Cupertino with our customers.  

In the course of time the SIMI°Evolution even developed new species : 

• SIMI°BioCell looks into the microscope.  

• SIMI°Scout the latest creature in the line offers analysis of 
behaviour, interaction and communication. In the field of sports a 
new dimension in game and tactical analysis was born. 

Would you like to join the SIMI°Evolution, even taking over an active part 
to develop the variety of species that analyse dynamic processes? Feel free to 
contact us, we are looking forward to your suggestions. 
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Installing 
software for 
Windows 
Installing SIMI°BioCell is as easy as you might think of! 

You need... 

• an IBM compatible PC with at least 8 MB memory and 3 MB 
free space on your harddisk. 

• a laser videodisc player (e.g. Sony LVD-8000P) connected to a 
serial port of your PC as source for the video data and a video 
board with live video display capability (e.g. ///FAST Screen 
Machine). 

• or as alternative Microsoft Video for Windows, a video capture 
board with compression (e.g. M-JPEG) and any video source for 
the video data. 

• Microsoft Windows 3.1 

To install... 

• Just execute "install.exe" on the installation disk. 

• Enter the destination directory in which you want SIMI°BioCell 
being installed.  

• Press the OK button! Icons for the program are created 
automatically. 

• Don't forget to connect the dongle at the parallel or serial port! 

Chapter 
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Getting Started with 
SIMI°BioCell 
In this session you will learn how to composite a video 
recording and SIMI°BioCell, the basic handling of this 
software and how to use it as a convenient lineage tool.  

his chapter is thought for users who never have worked with this 
software so far. It accompanies you from inserting the disk, creating a 
new project to finish your first lineage session. A complete 
description of all functions you will find in the Chapter 4 List of 

Functions. 

1 Starting SIMI°BioCell 
Assuming you have already installed the SIMI°BioCell software and are set 
up with the hardware devices, you are ready to start your first lineage session. 

• Insert the disk. 

• Double-click on the SIMI°BioCell icon. 

You will see SIMI°BioCell on-screen (Fig. 2.1). To find out what you are 
looking at, read on. 

2 What is on the screen 

 

Figure 2.1 SIMI°BioCell screen. 

Chapter 

2 
T

Start SIMI°BioCell 
by clicking on 
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The following section details the SIMI°BioCell window. 

2.1 Title Bar 
The top of SIMI°BioCell’s window is the title bar, a standard Windows 
feature. Here, SIMI°BioCell displays its own name. In addition, you see the 
title of the document. 

2.2 Menu Bar 
You find the titles of SIMI°BioCell’s menus, from which you can choose  

• File This menu enables access to various file management, 
printing and information options. 

• Edit The Edit pulldown menu contains, in contrast to other 
Windows applications, specific cell lineage editing options like 
Cell... description and colouring menus (Mark...).  

• View Toggles the visibility of fates, names and other 
information in the Cell lineage window. Furthermore, it offers 
access to SIMI°BioCell tools like the 3d-view. 

• Video This menu contains the play back functions like 
Frame step forward and Level increase. 

• Extras This menu contains the Navigator and the Collision 
Manager. 

• Options Presents a pop-up menu for selecting preference items 
like autosave and auto center cell. It is important to know that 
you could set up the Cross wire.  

• Window Here, you could arrange the windows. 

• Help This menu offers access to SIMI°BioCell’s on-line 
help directory - but hey, you have got this book. 

2.3 Toolbar 
The toolbar contains buttons, that enable easy access to frequently used 
SIMI°BioCell commands and tools. 

 New project 
 Open project 
 Save project 
 Show standard lineage 

 Center active cell 

You will find a 
detailed description of 
all menus in Chapter 
4. 

Tools, like the 3D-
model, the lineage 
navigator, are 
described in Chapter 
3. 
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 Zoom in horizontally 
 Zoom out horizontally 
 Zoom in vertically 
 Zoom out vertically 
 Free zoom 

 Open the 3d model 
 Video image 
 Information window 
 Map window 

 Frame fast backward 
 Frame step backward 
 Frame fast forward 
 Frame step forward 
 Level fast decrease 
 Level step decrease 
 Level fast increase 
 Level step increase 

 Mitosis 

For the Time-Challenged 

Do not spend too much time trying to learn all the options on the 
menu bar. You will not use all of them frequently. Many options 
are available on the tool bar, a lot of them are accessible by 
double-clicks or keyboard commands and for the most 
important functions SIMI°BioCell provides short cuts. 

2.4 Application Workspace 
Here, SIMI°BioCell displays the file you are currently working on, the video 
image and all tools you have additionally activated. If the windows are bigger 
than the available application workspace, the scroll bars are activated. You 
can click the scroll arrows, or drag the scroll bars, to bring hidden portions of 
the document into view. 

3 Basic windows callisthenics 
3.1 Moving the Window 
To place the various windows of SIMI°BioCell: 
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• Move the mouse pointer to the title bar, hold down the left mouse 
button, and drag. 

• When you have moved the window to the right place, release the 
mouse button. 

3.2 Sizing the Windows: 
To size the SIMI°BioCell windows : 

• Move the mouse pointer to one of the window’s borders until the 
pointer change's shape, and drag the border. 

• When you have sized the window the way you want, release the 
mouse button 

To size two borders at once, click on one of the corners and drag. 

4 Creating a new project 
In this section the integration of a recording into a SIMI°BioCell project is 
described. For a new project you need to link a standard lineage (that is 
normally the Sulston lineage) serving as a template with a time lapsed video 
recording of a C. elegans embryo. 

 

Figure 2.2 Open template dialogue box. 

Lineaging with SIMI°BioCell means to build up your own lineage of a 
recorded embryo based on a template lineage. 

4.1 To access to one of your recordings 
You have inserted a disk with a time lapsed video recording that starts (in our 
example) at around the 4 cell stage and lasts some division rounds. 

• Click on the File menu and double-click on New Project.... The 
Open template dialogue box provides files with standard lineage 
trees at various recording conditions (e.g. temperature), so called 
templates, as shown in Figure 2.2. 

Now that you have 
gone to all the trouble 
to position the 
window the way you 
want, SIMI°BioCell 
automatically saves 
your choices. 
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• Select sulst25.sbt. Now, SIMI°BioCell starts to read the 
directory file of the disk, that may take some time. Afterwards 
you will see the Video medium dialogue box, as shown in Figure 
2.3. 

• This box displays a list of all recordings on the disk including 
information about the scan start, the length, level, time etc. 
Choose your desired recording by double-clicking on its name or 
by clicking and pressing the OK button. 

 

Figure 2.3 Video medium dialogue box. 

 

Figure 2.4 SIMI°BioCell main window, Cell lineage and Video Image windows, as well 
as the Start frame dialogue box. Here, the Cell lineage window is active! 

4.2 To adjust a SIMI°BioCell template to your recording  
On the workspace you will see the Start frame dialogue box that helps you 
to adjust the beginning of a recording to a certain template (which normally 
starts at P0, of course), as shown in Figure 2.4. 

Use the scroll bar to 
find your recording! 
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• Double-click on the Video button to open the first scan in the 
Start frame dialogue box. 

• Focus on the nucleus of an AB daughter by using the scroll bar 
Level 

• Click on the window Video Image to activate it and play the 
recording until the two AB daughters are dividing by using the 
cursor control → or the Frame step forward button on the tool 
bar. 

• You either estimate the beginning of your recording or you count 
the number of scans (steps) between the first scan and the first 
division. 

• Now, click on the window Cell lineage that contains the template 
lineage tree as a grey setting, as shown in Figure 2.4. 

• Use the scroll bar Time to place the blue time line of the window 
Cell lineage between the AB and ABx division. 

• Press the OK button or return. The template is now adjusted to 
your recording, as shown in Figure 2.5. 

 

Figure 2.5 SIMI°BioCell main window, Cell lineage and Video Image. Here, the Cell 
lineage window is active. Note, that the new part of cell lineage adjusted to your recording is 
black and the mitosis are marked as green points. 

4.3 The Cell lineage window 
The Start frame box is disappeared. You see the Cell lineage window with 
the Sulston tree as grey setting and the new black cell lineage of your project, 
as shown in Fig. 3.5. The blue time line indicates the beginning of the 
recording referring to the template. In our example the recording starts during 

If you have counted x 
scans, place the time 
line on the ABx 
mitosis of the 
template setting, and 
go x steps back. 
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the 4 cell stage, therefor the branches of the previous stages are automatically 
generated and are already displayed. 

• Click on the black branch of the ABa cell. It switches to blue, 
which means it is active now, as shown in Figure 2.6. 

• Click on the Video Image window and focus the ABa nucleus 
(either using the tool bar or the cursor keys ↑ and ↓) 

• Move the tip of the mouse pointer so that it is positioned at the 
centre of the nucleus on the video image and click on it with the 
RIGHT mouse button. Forget all the double-clicking stuff; you 
just click once. 

A red cross appears indicating that the position of the cell on the video image 
and the scan number as well are stored, as shown in Figure 2.7. This 
information is shown off with a red point at the corresponding time in the 
lineage tree. If you click on a red point in this lineage tree the corresponding 
cell marked with the red cross will be displayed in the Video Image window. 

• Activate the right branch (that of ABp) and mark ABp, continue 
with EMS and P2. 

 

Figure 2.6 SIMI°BioCell main window, Cell lineage and Video Image. Here, the Cell 
lineage window is active. Note, the branch of the AB daughter ABa is blue (bold type)now, 
that means it is activated. 
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Figure 2.7 SIMI°BioCell main window, Cell lineage and Video Image. Here, the Video 
Image window is active. Note, the red cross on the Video Image is indicating the position of 
ABa and the red point in the Cell lineage window is indicating the corresponding position in 
the cell lineage. 

4.4 Save your project! 
To save a project: 

• Choose  from the toolbar. A File Info dialogue box appears. 
Fill in your name and press the OK button or simply return. 

The File Info dialogue box allows optionally to fill in the author's name, the 
project and comments like the recording conditions, see Figure 2.8. 

 

Figure 2.8 File Info dialogue box. 
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5 The first lineage session 
The real work starts now. You have to follow cells, mark them with the 
RIGHT mouse button on the video image, to enter mitosis and finally to 
determine the cell fate at the end of a recording. Follow the next section to 
learn how to use the SIMI°BioCell lineage software. 

5.1 Entering a mitosis 
Lineaging means to follow a cell until it is dividing and then to continue with 
one of its daughters. 

• Activate the branch of the ABa cell (it is now highlighted in 
blue). Follow this cell by playing the recording. 

• Mark the ABa cell time by time. 

• If it starts to divide press either return or the mitosis button on the 
tool bar. A fork is created (a mitosis is indicated by a green 
point). 

• Choose a daughter and follow it up to the 12 cell stage, see Figure 
2.9 and 2.10. 

 

Figure 2.9 Cell lineage window. A fork is created for the two daughters ABal and ABar. 
The point for the mitosis is coloured green and named with the mothers name, in this case 
ABa, of course. 

5.2 Making use of the software 
Up to now you spent more time on this program than you got out! This will 
change right now. While lineaging you "lose" a cell you are following for 
many reasons (and it happens all the time): 

After having inserted 
a mitosis, instead of 
clicking on a branch 
press 1 (3) on the 
numeric pad for the 
anterior (posterior) 
daughter. Switching 
to the sister goes with 
4 and 6. 
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• Click on the last red point of the current cell. 

The recording immediately jumps back to this position displaying a red cross 
on the corresponding position. 

• Try again! 

 

Figure 2.10 Cell lineage window. Lineage of ABala. 

5.3 Fixed points are indispensable for the SIMI°BioCell 
tools! 
Most of the SIMI°BioCell tools require that all cells at a certain time are 
marked. This function helps and forces you to do so. You have completed the 
lineage up to the 12 cell stage. 

• Click on one of the points. 

• Choose Edit from the menu bar and click again on Fixed points. 
A Fixed Points dialogue box will be shown. 

• Press the add button and fill in a name (optional). Press twice 
return to return to the Cell lineage window. 

 

Use the 0 key of the 
numeric pad to jump 
to the last point or 
control + 0 to jump 
to next red point! 

It is useful to have 
every 20 minutes a 
fixed point line!  
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A stippled time line is visible. You can only pass this line if you mark a cell 
at exactly this time! 

 

Figure 2.11 The complete lineage of an embryo to the 12cell stage. A stippled line at 60min 
(note the time strip at the left side of the Cell lineage window), the fixed point, is visible. 

The interactive windows of SIMI°BioCell 

If you have marked a cell on the video image, a data set for this 
cell will be created (its name, its position in the embryo, its birth 
time etc.) and stored in a database, a SIMI°BioCell project. 
These data sets are organised as members of the lineage and 
displayed on the Cell lineage window as points. To access to 
certain cell information and the corresponding video image you 
have simply to click on a point or a branch. Furthermore you 
could edit and analyse these data sets, of course. See Chapter 
5.1! 

 

5.4 Determine a cell fate 
Information about a cell are accessible in the Cell information and dialogue 
box. Here, you could enter deviations to the Sulston lineage, too. 

• Follow one cell to the end of a recording and determine its cell 
fate. 

• Double-click on the branch or click on Edit and again on Cell... . 

The Cell dialogue box will appear, as shown in Figure 2.12. It gives 
information about the actual cell. Choose a fate! The last red point of this cell 
in the lineage has now a legend. 

Watch out chapter 
5.1 for advanced 
actions on points and 
branches!  
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5.5 Deleting a point 
Information considering a red point, that is like a snapshot during a cell life, 
are accessible in the Point information and dialogue box. This box is also 
very useful, if you want to delete a point, for example if you have mixed up 
two cells. 

• Double-click on a red point. You will see the Point dialogue box, 
see Figure 2.13. 

• Press the Delete button to remove the current point. 

 

Figure 2.12 The Cell dialogue box. Abalaaaalal is a neurone! 

 

Figure 2.13 The Point dialogue box. It tells you the time and level. Fill in a comment and 
press the OK button, the comment will be shown in the Information box. Press Delete to 
delete the point. 

5.6 Deleting a sub-lineage 
Of, course, it is possible to act on a complete sub-lineage! 

• Click with the RIGHT mouse button on a point. You 
will see a cell edit menu. 

• Choose Delete all points downwards. 

Choose the 
Information box 
from the tool bar; it is 
very useful to show 
notes written in the 
Point dialogue box.  

In chapter 3 a 
complete section 
describes how to copy 
or to exchange 
complete sub-
lineages. 



 

 14  

6 Quitting SIMI°BioCell 
So, you are done. It is about 5 AM, isn’t it? Hope you had fun. To quit 
SIMI°BioCell : 

• From the File menu, choose Exit or press Alt + F4. 

6.1 From Here 
Now, you have learned to lineage with SIMI°BioCell. ...  

• Read Chapter 3 to see the SIMI°BioCell tools. 

• Use Chapter 4 as a complete reference of all functions. 

• Running into problems - Check out Appendix B. 
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SIMI°BioCell tools 
In this chapter all SIMI°BioCell tools are 
introduced. 

he SIMI°BioCell tools require a database with lineage information. 
These tools produce based on this once generated database secondary 
information. Some otheer tools may be still used as lineage support 
like the collision manager. Others help to analyse the cells within a 

three dimensional embryonic context. 

1 The 3D-model 
The 3D-model is the projection of the lineage data into the third dimension. 
Every point or cross is represented by a sphere that is used to build up a 3 
dimensional embryo.  

1.1 Requirements 
In Chapter 2 „Creating a new project“ you have learned to create a database 
or lineage project. These information are necessary to build a three-
dimensional embryo. You need a project that contains at least a complete 
lineaged cell stage or a complete lineaged blastomere. Furthermore, it has to 
be lineaged with the Fixed points option.  

1.2 The 3D model window 
• Click on a point of the fixed point line, e.g., at the 12cell stage. 

• Open the 3D model window by pressing  on the tool bar. 

The 3D model window has an application workspace that shows the 3 
dimensional model of the lineage and several option buttons, combo boxes 
and scroll bars to edit the presentation and orientation of the model, as shown 
in Figure 3.1.  

Chapter  

3 
T
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Figure 3.1 The SIMI°BioCell main window, the Cell lineage window and the active 3D 
model window. A 3d model of an 12cell stage is shown. 

Like the Cell lineage window the 3D model window is also interactive. 

• Place the mouse pointer on a sphere. A yellow 
flag the Fly over information tells you the 
cell’s identity, its fate, the time of birth and the 
level, as shown in Figure 3.2. 

• Double-click on a sphere and the corresponding point in the Cell 
lineage window is shown. 

Double-click on a sphere and the corresponding point in the Cell lineage 
windows is shown, double-click on a point and the corresponding sphere is 
highlighted in the 3D model window and have a look at the Video Image to 
see the cross at the corresponding position.  

There is an interactive link between these windows, o.k., that’s fine -nice 
software. No! Hey, haven’t you realised that - this is the first time in your life 
that you can identify a cell in an organism by simply clicking on it! 

LEVEL: tells you the 
real level of the scan 
whereas CURLEV: is 
the fictive level after 
the embryo was 
rotated. 
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Figure 3.2 Fly over information of the ABp blastomere. 

This chapter focuses on the Rotate control sphere and the Options... button. 
You find a complete description of all functions in Chapter 4. 

1.3 The Rotate control 
To rotate the 3D model simply use the cursor buttons on the sphere. The 
degree of a horizontal, vertical or circular rotation is displayed below. Since 
most of the embryos do not behave like an ideal body one has to set up the 
geometry of an embryo for a certain purpose (see Chapter 4). 
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Figure 3.4 3D model window with big spheres. 

1.4 Options 
• Open the 3D options dialogue box by pressing the Options... 

button, as shown in Figure 3.3. 

The 3D view group box is to size the spheres the way you want, e.g. Figure 
3.4. 

• Fill in a number between 1 and 13 to settle the number of 
different sizes. 

• Check off small, medium or big to limit the maximum sphere 
size. 

The Fly over information group box provides information of a cell point to 
select. 

• Check off the information you want to see in the yellow Fly over 
flag 
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2 Cell movement 
The cell movement function displays either the ancestors or the descendants 
of a certain blastomere.  

2.1 Cell movement displayed on the Video Image 
• Click on the desired point. 

• Choose in the View menu Cell movement… .The Cell 
movement box appears. Check off Previous for the ancestors or 
Following for the descendants.  

• This box lets select you 0 for only the active cell or 1, 2, …up to 
all, for a certain number of generations of ancestors or 
descendants. 

 
All chosen ancestors will be displayed on the Video Image as 
crosses that are linked to each other. If you have to many points 
or generations it might look a little bit overcrowded. If you 
would like to study cell movement in detail it is recommended 
to clean out a project having only points on the Fixed points 
line. This tool is also valuable to check your lineage. Assuming 
that before morphogenisis most descendants stay together. A blastomere that 
suddenly moves out of that region might be a lineage error.  

2.2 Cell movement displayed on the 3D model 
• Click on the desired point. 

• Open the 3D model. 

• Press the  Movement… button. The Cell movement box 
appears. Check off Previous for the ancestors or Following for 
the descendants.  

• This box lets select you 0 for only the active cell or 1, 2, …up to 
all, for a certain number of generations of ancestors or 
descendants. 

All chosen ancestors will be displayed on the Video Image as spheres that 
are linked to each other. Note, that every point will be displayed. If you have 
to many points or generations it might look a little bit overcrowded. If you 
would like to study the cell movement in detail it is recommended to clean 
out a project having only points on the Fixed points line. To facilitate the 3D 
view you have to options.  

• Check off Show only movement in the Cell movement box. 

Note, that all points 
between two mitosis 
are displayed. As 
consequence, 0 
produces also some 
crosses. 
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• Choose different colours for the first and the last blastomere of a 
cell movement. Press the Colours… button! 

3 The Collision Manager 
The collision manager has an eye on your work. The 
collision manager checks the cellular environment of a 
given active cell. It calculates the distance to neighbours and 
warns you if you think lineaging different cells but actually 
do tracking the same cell. 

• Choose Collision Manager… from the Extras 
menu. The Collision Manager dialogues box will appear. 

• Fill in the Range values to set the tolerance of the collision 
manger. Every pair of cells with values within the specified range 
will be  considered as a collision and therefore displayed in the 
window. 

• Press Ok! 

• Enable the collision manager in the Options menu. 

While you are lineaging (assigning crosses to cells) the 
collision manger checks automatically whether you are 
following a new cell or whether you are lineaging a 
previously lineaged cell that is derived from another 
ancestor. In the latter case the collision manager displays an 
info box and next the Collision Manager dialogue box 

again. The current cell and the collisioning cell(s) are listed. Differences in 
timing and distance are shown beside. By clicking on the cell name the 
program jumps to the corresponding position in the Cell lineage window 
helping you to find quickly the other cell.  

To correct the lineage SIMI°BioCell offers several possibilities that are 
described in the following chapter “Copy and Paste”. 

4 Copy and Paste  
Once the collision manager has ringed the alarm bell the trouble starts 
because you have mixed up two cells. This sections describes how to deal 
with that problem. First, you should think about alternative routes to come to 
another cell. Second, you need to repair the lineage either by deleting points 
or by rearranging sub-lineages.  

4.1 Alternative lineages for one cell 
• Select a cell that is indicated by the collision manager. 

The collision manager 
compares only cells 
represented by points 
in the Cell Lineage 
window. It does not 
interpolate putative 
positions of a cell 
between two points! 

To keep the 
application workspace 
with the various 
windows manageable 
make use of the 
Reduce < button 
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• Choose Add branch from the Edit menu. A blank lineage is 
provided. The original lineage still exists as shown by small line 
beside the line of the next cell. 

• Try to find a new route for the lineage to create an alternative 
lineage. 

• You can switch between alternatives by using the “TAB” key. 

You may check the alternative lineage with collision manager. There are lots 
of cases where a situation remains unclear. In this case keep the alternatives 
and make use of the Information box. 

4.2 Copy and Paste lineages 
You have found the right route for the cell. If the original version of the sub-
lineage was totally screwed up you may delete it as well as any other 
alternative lineage by choosing Delete branch from the Edit menu. Most of 
the time it turns out that you have mixed up two cells but the subsequent 
lineage is correct. Deleting this alternative and lineage the same stuff from 
the right cell again will be a enormous amount of work- you want to keep the 
points but put them to another place. SIMI°BioCell offers to rearrange 
sublineages - copy and paste sub-lineages. 

• Save the current project! 

• Choose a destination cell. 

• Move the mouse pointer to the desired source 
lineage that should moved, hold down the left 
mouse button and drag. 

• When you have moved the lineage to the destination place, 
release the mouse button. The Move branch box appears. 

• Check off for Swap to exchange the source and destination 
lineages, Copy to overwrite the destination lineage with the 
source while keeping the source, Move to overwrite the 
destination lineage with the source without keeping it and Add to 
automatically create an alternative lineage including the source 
one. 

Done! The Add option is the safest one, of course. Anyway, if larger parts 
are rearranged review them. 

5 Tips and Tricks  
The goal of the previous sections was to work out and then analyse the 
complete lineage of an embryo. This section focuses on lineaging a specific 
cell or subset of cells. For example one would like to lineage in different 

Please, pay attention 
to the generations. It 
should be the same or 
an earlier one! 
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embryos always the hypodermal cell H0R that is ABa r p a p p p a . The 
Navigator automatically provides the cleavage directions and prevents you 
from figuring out the a/p code. Or vice versa, you might have a fluorescence 
image that corresponds to the last scan of a recording and you would like to 
identify all stained cells. SIMI°BioCell provides “backward lineaging” 
features for this purpose. 

 

5.1 The Navigator 
• Choose a free branch of any precursor of H0R. 

5.2 Backwards lineaging 
• Choose a free branch. 

• Disable the fixed points in the Options menu. 

• Play the recording to the end (or to any other scan) 

• Mark the desired cell 

• Play the recording back; always mark it! 

• Shortly before a mitosis occurs, this time the fusion of your cell 
with its daughter, mark the cell. 

• Step a few scans back to the event of the mitosis. If you have 
followed the anterior (posterior) daughter choose Insert Mitosis 
left (right) from the Edit menu.  

• Go ahead! 

Often it turns out that one has chosen the wrong starting branch. For this 
problem see section 4.2. 
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User's Reference 
In this chapter are all functions and 
commands listed and described. 

ser's Reference gives a complete list of all functions and commands. 
It is organised the way, that you start, e.g., with the File menu and 
get information about all submenus, buttons etc.. Cross-references 
to Chapter 2 and 3  facilitate an efficient access. 

1 File 
1.1 New Project 
Creates a new project; see Chapter 2 „Creating a new project“ for an 
introduction; here, you find the details.  

1.1.1 Open template window 
Name.sbt are templates for various recording conditions, for example 
sulst25.sbt should be used for recordings at 25oC (see Figure 2.2). It is 
possible to create a new template files (see Chapter 5 (3.2)). 

Buttons in the Open template window work as follows 

OK Click on OK to accept selection; press return for short.. 

Cancel Back to the main window without any changes. 

Info… Displays the File info dialogue box. 

Action… Produces a file manger pull-down menu. 

1.1.2 Video medium 
The Video medium dialogue box is basically thought to simply select a 
certain recording. Buttons like Load are only useful, if you want to organise 
all your recordings on several disks as a small database. 

Buttons in the Open template window work as follows 

OK Or return opens the selected recording. 

Video Opens the image of the selected recording to preview. 

Read  Reads the current video disk. SIMI°BioCell stores all recordings of a 
disk to files named file0000.sbl in the content directory. Read creates 
an update. 

List If available this displays a list of changes of record intervals and 
focus changes done during the recording of a file. 

Chapter 

4 
U
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Edit Produces the Record attributes read-only dialogue box. All 
information of a file on a certain disk are displayed. If the disk is a ROM data 
storage, the attributes cannot be changed! 

Load Lets you select a content file other than displayed. Useful when 
checking several disks since the size of such a file is limited. 

Save Only necessary if you want to save the current file but under a 
different name in a different directory, e.g., instead of file0001.sbl 
disk_01.sbl in the directory usergroup_1. The dialogue box lets you 
select the file's name and place. 

1.2 Open project 
Lets you select a file to open from a dialogue box.  

1.3 Save project 
Saves the current Cell lineage file. 

1.4 Save project as... 
Creates a new file of the current cell lineage file. A dialogue box lets you 
select the file's name and place. It opens also the File Info box that displays 
file information and offers also the opportunity to fill in additional ones.  

1.5 Close project 
Closes the current cell lineage file. A dialogue box lets you choose between 
saving the file (press Yes) or keeping the last version (press No). 

1.6 Load standard cell lineage... 
Produces a Load standard cell lineage box that lets you select either the 
standard Sulston lineage or a yourself created file. 

1.7 Compare with lineage… 
Compares the points of two lineages. First you can chose a lineage to which 
you can compare the current lineage, the SIMI°BioCell asks for the output 
file. This produces a ASCII text file with the following format: 

<file name 1> 
<file name 2> 
... 
<cell name file 1> <time of point> <x position of point><y><z> 
<cell name file 2> <time of point> <x position of point><y><z> 
<cell name file 1> <time of point> <x position of point><y><z> 
<cell name file 2> <time of point> <x position of point><y><z> 
... 

1.8 Export fates… 
Exports the fates from selected cells into an ASCII text file. See at 
SBIOCELL.INI, section TEXTFATE for more details. 
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The resulting text file has also a "tree structure", the cells are separated by 
tabulators. If a cell has a fate, this is marked with the corresponding letter. 

1.9 Export mitosis times… 
Creates an Export to text file dialogue box that allows you to save the time 
of all mitosis in a text file.  

1.10 File Info... 
Displays the File Info dialogue box. 

1.11 Print... 
It is a simple output option to print directly. It prints the lineage tree from an 
activated point without adjustment to the full page. The Copy dialogue box in 
the Edit menu is much more convenient! 

1.12 Printer setup... 
To set up a printer. 

1.13 Exit 
Closes the current Cell lineage file and quits the SIMI°BioCell application. A 
dialogue box lets you choose between saving the file (press Yes) or keeping 
the last version (press No). 

2 Edit 
The most options of the Edit menu are accessible by clicking on a point or a 
branch! 

2.1 Copy... 
Copies the current cell lineage file to the clipboard. The content of this 
clipboard can be pasted into a graphic application's file like of Paintbrush or 
Corral Draw. The Copy box provides several options to either use the 
complete content of the Cell lineage window or only part of it. Note, that 
some graphic applications require a bitmap format! 

2.2 Mitosis 
To generate a new mitosis. Better use the short cuts! 

2.3 Insert Mitosis left 
An option required for backwards lineaging. If one traces a cell at late stages 
backwards to earlier ones, one can insert mitosis by mitosis to build a sub-
lineage. The copy and paste function can place it to the right ancestor. 

2.4 Insert Mitosis right 
See 2.3 

2.5 Add branch 
In some cases several routes seem to apply for one cell. They can be stored as 
alternatives by Add branch and are indicated by a small line beside the line 

Only the sublineage 
downstream of the 
active cell point will 
be copied! 

Double-click on the 
branch of the desired 
cell to access this box 
faster! 
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of the next cell. The comparison of these alternatives should facilitate a final 
decision for one rout (See chapter 3, 5.1). 

2.6 Delete branch 
To remove alternatives. 

2.7 Cell... 
The Cell dialogue box provides information of the current cell. Fate 
assignments can be chosen and comments can be written. The fate is shown 
in the Cell lineage window as shortcut, e.g., H for hypodermis, and the 
comments are displayed in the upper part of the Information box. Since 
those comments are always shown write only general comments that consider 
the complete lineage of the current cell. For notes referring to a certain point 
use the Point dialogue box (see below)!  

The information of the group box „Normal:“ is derived from the current used 
standard cell lineage. If you plan to design your own standard cell lineage, it 
is necessary to fill in the group box „Actual:“. This information will be 
displayed in „Normal:“, if you use the current project as standard cell lineage 
in a new project. 

2.8 Point... 
The Point box contents information of a certain point in a certain lineage of a 
cell. You can fill in a comment that is displayed in the lower part of the 
Information box. Furthermore you can delete this point by pressing Delete. 

2.9 Mark... 
With the Colours menu you can mark the current cell branch between two 
mitosis with a colour. 

2.10 Unmark... 
Returns the coloured cell branch to black. 

2.11 Mark all... 
To colour all cells of the Cell lineage tree. 

2.12 Unmark all... 
Returns the colour of all cells to black. 

2.13 Fixed points... 
This option generates a barrier visible by a stippled line in the Cell lineage 
window. To pass by you have to mark the current cell. Some tools of 
SIMI°BioCell requires the position of all cells at a certain time.  

3 View 
3.1 Fates and names, Generations and standard lineage 
Toggles the visibility of Fates, names, of the division round and of the 
standard lineage. 

Double-click on the 
red point of the 
desired cell to access 
this box faster! 

It is useful to 
highlight a few cells 
with a special colour 
for some purpose, 
e.g., checking two 
cells in a close 
neighbourhood that 
derive from different 
blastomeres. 
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3.2 Video window, Status window 
Toggles the visibility of the Video Image windows and the Information 
box. 

3.3 Cell movement... 
This option is helpful, if you want to study the movement of one cell or a 
clone of cells during embryogenesis.  

It produces a Cell movement dialogue box. Check off Previous (Following) 
to show all points of the previous (following) generations. On the Video 
Image window you will see all crosses joined with a line that resembles the 
movement of the current cell (bold type).  

3.4 Cell list… 
This option is required to colour the branches in the Cell lineage window as 
well as the spheres in the 3d-model window. The SIMI°BioCell software 
provides two ways to use colours. Here, it is described, how to colour 
descendants of a certain blastomere or cells of a certain tissue. In the Options 
menu the Colours box could be used to colour the layout of the lineage like 
the colour of the active point, of the mitosis or of the background. 

It produces the Cell list box that displays a list of a set of cells, that you could 
define on your own.  

• Check off Cells existing at current time for cells that are 
existing at the current time or All cells for all existing cells etc. to 
generate the corresponding list.  

• Now select a subset of cells to either mark or unmark it, e.g., 
select all E derived cells.  

• Press Mark to open the Colour box and choose a colour, e.g., 
green to highlight the intestine in the embryo.  

• Repeat this procedure to colour every desired cell or clone of 
cells. 

• The subsets with the corresponding colours can be stored as 
presettings by pressing Save. Of course, you can load this 
presetting by pressing Load.  

• Navigator  

3.5 3D-model... 
Produces the 3D model window, as shown in Figure 3.1. Chapter 3 describes 
the interactive application workspace. The following section details the 
option buttons of this window. 

Only cells of the 
database, that means 
already lineaged cells 
will be coloured. 
Practically, you have 
sometimes to colour 
your lineage again or 
to load a pre-setting. 

Scroll down and press 
shift ( ⇑ ) + first and 
last E-descendant to 
mark all in-between.  
Or Scroll down and 
press control (Strg) + 
first and last E-
descendant to mark 
only the first and the  
last one. 
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3.5.1 Levels 
This combo box toggles the visibility of a single level, a group of levels or 
all.  

• Click on level 0. 

• Scroll down and press shift ( ⇑ ) + level 8. Only the upper third of 
the 3D model of the embryo is visible. 

• Scroll down and press control (Strg) + level 8. Only level 0 and 
8 are visible in the 3D model. 

This allows you to cut virtually the embryos into sections and facilitates 
massively the analysis of a 558- cell embryo. 

3.5.2 Distance 
This scroll bar controls the distance between the levels, that means along the 
z-axis. If you want to rotate the embryo you adjust the distance until the 
embryo rotates like a cylinder. If the distance is to short, you will rotate a 
disk, if it is to far, the embryo will crawl over the application workspace. 

3.5.3 Rotate 
To rotate the embryo in three axis. The  button is to reset. 

3.5.4 Zoom 
This box controls the overall size of the 3D model, that means zooming along 
all axis and is therefore different from the Distance scroll bar. Use the 
buttons zoom in, reset and zoom out or just fill in. 

3.5.5 Movement... 
This button works exactly the same as the Cell movement... option in the 
View menu.  

3.5.6 Options... 
The 3D options dialogue box controls the lay out of the 3D model, see also 
Figure 3.4. Fields in the 3D options dialogue box work as follows: 

Zoom Controls the Zoom box to zoom either linear or exponential. 

3D view Select the number of different sphere sizes and limit the 
maximum size with small, medium and big size. Note, that you only get the 
full range of sphere sizes, if you have checked off big size! 

Cell movement spheres You can define with the Colour... button (see 
below) a set of colours to mark certain spheres in the 3D model and a set to 
mark spheres specifically for the option Cell movement. If you want to use 
the same colours for both sets, you can switch between the two modes 
„colour selected for movement“ and „colour for marking“. 

Fly over information Toggles the visibility of different information in the 
yellow fly over flag. 

If you want to rotate 
an embryo, try to 
optimise it with the 
Distance scroll bar. If 
that does not work 
properly use the 
Center... button in 
addition. 
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Check off „Save options when closing“, if you want to keep the options after 
closing the project or quitting SIMI°BioCell. 

3.5.7 Colours... 
This button works exactly the same as the Colours... option in the Options 
menu. Note, changes apply always to both options! 

3.5.8 Center... 
This dialogue box helps to adjust the 3D model of an embryo to its shape and 
orientation of the Video Image. Default is always the automatic centring of 
the available spheres in the 3D model window. For user’s defined placing 
check off „check during input“ in the Edges (x-axis, y-axis) field. 

• Place suitably the Center... dialogue box and the Video Image 
window. 

• Check off „check during input“ in the Edges (x-axis, y-axis) field 

• Click on top in the dialogue box, a red point in the left field is 
visible. 

• Click on the top of the embryo on the Video Image. This position 
is now stored and the right position is highlighted. Click on the 
most right position of the embryo on the Video Image. Continue 
for bottom and left. 

• If you are not satisfied, press the New button. 

For example, you have three embryos on the Video Image window and you 
have adjusted the upper right, the 3D model of it should now appear at the 
upper right on the 3D model window. If you want to centre this embryo, use 
the Move field in the Center... dialogue box. 

If you are not using recordings with 25 levels, it might be useful to set up the 
levels in the Level (z-axis) field. 

All options will be saved for a certain project. 

3.6 Center active cell 
Places the current branch in the centre of the Cell lineage window. 

3.7 Center time line 
Places the current time line in the centre of the Cell lineage window. 

3.8 Zoom in etc. 
Zooming gradually. 

3.9 Free Zoom 
Zooming infinitive variable. 

To adjust your 
embryo, be aware of 
the options Distance, 
Zoom and Center...! 
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3.10 Next (Previous) branch 
Brings the next (previous) alternative (see 2.5). 

4 Video 
Scan control commands. Use the cursor control keys instead! 

Frame step forward Brings the next scan 

Frame step backward Brings the previous scan 

Frame fast forward Acceleration of Frame step forward 

Frame fast backward Acceleration of Frame step backward 

Level increase Brings the lower level of one scan 

Level decrease Brings the upper level of one scan 

Level fast increase Acceleration of Level increase 

Level fast decrease Acceleration of Level decrease 

4.1 Select video device… 
The Video device box appears. Check off the used video device. 

4.2 Set default video device… 
The Set default video device box appears. Check off the normally used 
video device. 

5 Extras 
5.1 Navigator 
The Navigator info box appears, press OK! Only the standard cell lineage is 
displayed. Select a cell by clicking on its branch. 

5.2 Collision Manager… 
This tool is completely described in chapter 3, 3. 

5.3 Take over colours… 
Displays the Take over colours info box. If your standard lineage is already 
coloured (though it is displayed in grey when used as background) you may 
use the same colours for the corresponding lineages in the new cell lineage. 
Pressing OK will take over the colours. 
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5.4 Insert time 
Allows to shift the time of a mitosis between mother and daughters without 
affecting the lineage. This option may be used to correct the starting time of a 
lineage if the new project was not properly set up or when mitosis are not 
precisely marked. 

• Save your project! 

• Click on the last point of the branch of the mother. 

• Step one scan forward 

• Insert as many time intervals as required to assign the right scan / 
time for the mitosis. Remember the amount of insertions! 

• Click on one daughter and step backward. 

• Delete as many time intervals as inserted previously. 

• Repeat the last two steps for the other daughter. 

Now, you have left unaffected all points above and below but changed the 
time of the mitosis. 

5.5 Delete time 
See 5.4 . 

6 Options 
6.1 Auto center cells 
Places the active cell automatically in the middle of the Cell lineage window. 

6.2 Enable fixed points 
To disable the fixed points means to remove the lineage barrier. To delete 
fixed points access the Fixed points... option 

6.3 Enable collision checking 
Enables or disables the collision manger. 

6.4 Options 
Presents a pop-up menu for selecting preference items. 

Fields and buttons in the dialogue box work as follows: 

6.4.1 General 
Beep... Sound presettings 

Big toolbar Enlarges the toolbar 

These two functions 
need to be handled 
very carefully 
otherwise you will 
screw up your 
lineage! 
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Create backup files Creates a name.bak backup file of the current project. 

Enable autosave Creates automatically a ~asv0000.sbd backup file 
that is used after SIMI°BioCell was unexpectedly closed and restarted again. 

Load contents... Loads and saves the content list of a disk automatically. 

Video co-ordinates The cross on the video image of the active cell can be 
also displayed at x level above or below. This option takes into account that 
the size of blastomeres of each generation changes and that therefore the 
range of levels showing parts of the blastomere differs. A traffic light is 
displayed on the bottom corner of the Video Image; green means current 
scan level is coincident with stored level of the point, yellow means x levels 
above or below and red when the current level is out of range. 

6.4.2 Presettings 
This field works exactly the same as the various options in the View and 
Options menu. 

6.4.3 Video control 
Defines the port of the graphic board. 

6.4.4 Cross wires 
The position of the cross of any cell on the Video Image is stored in a project 
file and independent of the hardware set up (if you are using an overlay board 
you have to calibrate the overlay). In contrary the adjustment of the cross 
wire on the high resolution screen to the cross on the Video Image is 
dependent of the interface and the currently loaded driver. X and Y settle the 
absolute position of the co-ordinates and DX, DY settle the spreading of the 
axis units. 

6.4.5 Directories 
Directories of the contents list and the template files. 

6.5 Colours... 
This dialogue box controls the colour of the lay out of cells, mitosis and the 
background. It has to be used for the Cell lineage and the 3D model 
windows. 

Point Colour of any point in the Cell lineage window 

Mitosis Colour of any mitosis in the Cell lineage window 

Fate (equal) Colour of fates as expected from the standard lineage 

Fate (unequal) Colour of fates different from the standard lineage 

Comment Colour of a point with a comment 

Cell (standard) Colour of the standard lineage 

Cell Colour of the new lineage of a certain project 
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Active cell Colour of the active cell 

Text Colour of the fates and names in the Cell lineage 
 window 

Time line Colour of the time line 

Fixed points Colour of the stippled line 

Background Colour of the window background 

Video - Cross Colour of the any cross displayed on the Video Image 

Video - Active cross Colour of the active cross of the corresponding level 

Video - line Colour of the cell joining line in the function cell 
 movement  

3D - Sphere Colour of any sphere in the 3D model window 

3D - Active Colour of the active sphere in the 3D model 
 window 

3D - Fate (equal) Colour of fates as expected from the standard lineage 

3D - Fate (unequal) Colour of fates that are different from the standard
  lineage 

3D - Movement sphere Colour of the spheres of a movement set 

3D - Movement start Colour of the first sphere of a movement set 

3D - Movement end Colour of the last sphere of a movement set 

3D - Fly-over Colour of the information flag in the 3D model 
information  window 

3D - Background Colour of the background of the 3D model window  

7 Window 
7.1 Tile, Cascade... 
To place windows on the SIMI°BioCell application workspace see Chapter 2. 

7.2 Repaint 
Brings a fresh copy of the current cell lineage to replace the original. The 
command affects only the window appearance. 

7.3 Help 

The on-line help is under construction! 
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Supplemental Material 
 

1 Pulldown menus of the Cell Lineage window 
 

Action 

 

Pull-down menu / 

 Dialogue box 

Double-click on point Point information 

Double-click on branch Cell information 

Right-button-click on point Edit options 

Right button-click on branch Edit + Mark options 

 

See Chapter 1 (5.4-5.6) and Chapter 4 (2  Edit) for descriptions of the 
options! 

2 Keyboard Shortcuts 
2.1 General 
F1 Help 
F5 Standard Lineage on/off 
<Ctrl>F8 Online Collision Checking on/off 
<Ctrl>F9 Fixed Points on/off 
<Ctrl>F10 Local Cell Menu 
+ Zoom in horizontally 
- Zoom out horizontally 
<Ctrl>+ Zoom in vertically 
<Ctrl>- Zoom out vertically 
<Ctrl>C Cell Dialogue 
<Ctrl>P Point Dialogue 
<Ctrl>S Save current File 
<Ctrl>W Repaint Window 
<Ctrl>M Mark Cell 
<Ctrl>U Unmark Cell 
<Ctrl><Shift><Insert> Insert Time (one Frame) 
<Ctrl><Shift><Delete>  Delete Time (one Frame) 
<Ctrl><Insert> Copy 
<Space> Center active Cell in Window 

Chapter 

5 
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<Ctrl><Space> Center Time Line in Window 
<Ctrl><Shift><Space> Center active Cell and Time Line in 

Window 
<Return> Mitosis 
<Shift><Return> Insert Mitosis and fix following 

lineage on the left 
<Ctrl><Return> Insert Mitosis and fix following 

lineage on the right 
<NumPad ,> Switch between Lineage Window and 

Video Window 
 
2.2 Dragging a Branch 
<Shift> Cut current Cell at Time Line 
 
2.3 Moving in the Lineage 
<Tab> Switch between alternative Branches forwards 
<Shift><Tab> Switch between alternative Branches 
backwards 
<NumPad 0> Jump to previous Point 
<Ctrl><NumPad 0> Jump to next Point 
<NumPad 1> Jump to left Successor 
<NumPad 2>  Jump to last active Successor 
<NumPad 3>  Jump to right Successor 
<NumPad 4>  Jump to left Neighbour 
<NumPad 5>  Jump to Predecessor 
<NumPad 6>  Jump to right Neighbour 
<Ctrl><Home> Jump to Root Cell 
<Ctrl><End> Jump to Bottom Cell (last active) 
 
2.4 Deleting all Points downwards 
<Ctrl> Delete also current point 
 
2.5 Scrolling 
<Left> Scroll Lineage left 
<Right> Scroll Lineage right 
<Up> Scroll Lineage up 
<Down> Scroll Lineage down 
<Ctrl>... Page scrolling 
 
2.6 Video Window 
<Home> Jump to first Video Frame 
<End> Jump to last Video Frame 
<NumPad ,> Switch between Lineage Window and Video Window 
 
<Left> Previous Frame 
<Right> Next Frame 
<Up> Level down 
<Down> Level up 
<Ctrl>... Bigger Steps 
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2.7 3D Window 
<ScrollLock><NumPad 2> Rotate X downwards 
<ScrollLock><NumPad 8> Rotate X upwards 
<ScrollLock><NumPad 4> Rotate Y left 
<ScrollLock><NumPad 6> Rotate Y right 
<ScrollLock><NumPad 1> Rotate Z anticlockwise 
<ScrollLock><NumPad 9> Rotate Z clockwise 
<ScrollLock>+ Zoom in 
<ScrollLock>- Zoom out 
<Ctrl>... Speed x2 
<Alt><Ctrl>... Speed x4 
 
<ScrollLock><NumPad 5> Zero position 
<Shift> Keep Flyover Information 

3 SIMI°BioCell Files  
All files created by SIMI°BioCell can be edited with a text editor. There is no 
reason to edit or change any of the files created by SIMI°BioCell. 

SIMI IS NOT RESPONSIBLE FOR ANY PROBLEMS OR DAMAGES 
CAUSED BY CHANGES OF ANY OF THE FILES LISTED BELOW! 

3.1 .sbd and .sbc 
A SIMI°BioCell project consists of two files. All created data of a project are 
stored in a text file .sbd. The .sbc file contains information of the 
corresponding disc and settings of the last lineage session as window size etc. 

WHEN COPYING A PROJECT YOU NEED TO COPY BOTH! 

3.2 .sbt 
It is a template file. If you have created your own standard file that you would 
like to define as a template file, you have to open an existing template file. In 
the line DATAFILE=*.SBD, you insert the name of your project selected for 
being a template file. You may also want to change the time extension or 
compression. This can be changed in the line TIMEFACTOR=800. In the 
most cases it is recommended to use the Load standard cell lineage option 
(see Chapter 4 (1.6)). 

3.3 .sbs 
This file contains your colour selection. 

3.4 SBIOCELL.INI 
3.4.1 Section [BIOCELL] 
PAINTDELAY delay time after painting a new video image for drawing 

something on it (milliseconds) 

AUTOSAVE filename of autosave file if it exists 



 

 37 

LVDOUT dump laserdisc directory to this file 

LVDIN read laserdisc directory from this file, not from the disc 

SCREENS number of screens connected to your computer 

DIALOGS alignment of dialogs: 1 = left, 2 = center, 3 = right 

3.4.2 Section [COLOURS] 
SIMI°BioCell saves its colours here. They can be set in the colours dialogue. 

3.4.3 Section [COMMENTS] 
COMMENT%i Here you can define as much standard comments as you 

want. Just give them successive numbers (instead of %i). 
The comments appear in the cell and point dialogues. 

3.4.4 Section [FATE] 
FATE%i Here you can define the possible fates for the cells. This setting is 

used for new files and then saved in the project file. Number 
each entry and start with 1 (FATE1=...) 
Attention: The fates are saved by their numbers! 
Format: FATE<No.>=<shortcut letter>,<description> 

3.4.5 Section [HISTORY] 
FILE%i the last used files (%i = number) 

3.4.6 Section [OPTIONS] 
SIMI°BioCell saves its options here. They can be set in the options dialogue. 

3.4.7 Section [TEXTFATE] 
CELL%i You can define here, which cells should be exported when you 

want to Export fates. Moreover, you can set how many 
generations following the specified cell should be exported. 
Number each entry and start with 1 (CELL1=...) 
Format: CELL<No.>=<gen. cell name>,<generations> 

3.4.8 Section [VIDEO] 
COM the COM port used for controlling the video device 

DEFAULTDEVICE the videodevice which is taken for a new file: 
NONE, OVERLAY or DIGITALVIDEO 

3.4.9 Section [WINDOWS] 
SIMI°BioCell saves its window positions here 

3.4.10 Section [3D] 
SIMI°BioCell saves its 3D options here. They can be set in the options 
dialogue in the 3D window. 


